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Rapid Disclaimer

The development of the RAPID software program was funded under contract by the Federal Aviation
Administration (FAA) and the USAF and is provided to the user as is. Neither the FAA nor the U.S.
Government warrants the merchantability of this software or its fithess for a particular use. Use of RAPID
or its output does not replace or change any part of the repair or alteration approval process. Users of
RAPID must obtain approval of any repair or alteration designed or analyzed with RAPID with the same
procedures as with any other analysis tool. A repair design from RAPID should never supercede that
supplied by the original equipment manufacturer (OEM). RAPID should be considered an alternative
design tool whenever a repair procedure is not provided or is not available from the OEM. In no instance
will the U.S. Government be liable for any damages sustained by the user, or any third party, caused by
or attributed to the use of the RAPID software.
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1. Introduction

This document provides installation and usage instructions for the Repair Assessment Procedure
and Integrated Design (RAPID) program. This version has a completely new look and feel.
All users should read this manual.

RAPID is a tool for the design and analysis of aircraft structural changes. This version assists
the user in designing an antenna installation as well as the mechanically fastened fuselage skin
repairs with up to three doublers. RAPID performs both static and damage tolerance analyses of
the repair. The static analysis determines if the mounting plates or doublers and fasteners are
statically adequate, while the damage tolerance analysis yields crack growth life and residual
strength.






2. Requirements

The following are the minimum hardware and software requirements for installing and running
the RAPID software:

e Pentium class CPU
* Windows 95, Windows 98, Windows NT 4.0

» Hard disks with 25 megabytes free disk space. The load spectra, if generated,
require an additional 11 megabytes each.

* 32 megabytes random access memory (RAM) (64 megabytes or more is
preferred).

» 3.5inch 1.44MB floppy disk drive.
» Super VGA, 800 by 600 dpi resolution (1024 by 768 or higher is recommended).

* Mouse or track-ball recommended.






3. RAPID Program Notes and Limitations

This section lists graphical user interface notes and program limitations for the current version of
RAPID. Updated versions of this information will be available in RAPID from the Readme
Information menu item in the Help pull-down menu.

3.1 RAPID Graphical User Interface Notes

3.2 RAPID Analysis Notes







4. Document Conventions

This manual uses the following special fonts:

ALL CAPS
Bold
Italic

Monospace

This type represents file categories or names and disk directories
This type represents application commands, menu items, edit fields, etc.
This type represents string(s) that are found in a file

This type represents text that user types or text as it appears on the
screen.






5. RAPID Support Services

5.1 Telephone Support

For technical assistance, problem reporting, or general questions regarding RAPID, please
contact:

RAPID Project Manager

FAA William J. Hughes Technical Center
Airframe Structures Section, AAR-431
Atlantic City International Airport, NJ 08405
http://aar400.tc.faa.gov/rapid

Any problems or difficulties encountered while running RAPID should be reported. If you
discover any problems with RAPID, fill out the RAPID Problem Description Form supplied in
the subsequent section documenting the events that led up to the problem in RAPID and the
manifestations of the problem. This form should be submitted as soon as the problem is
discovered. The same information may be supplied using e-mail if the user so desires.



5.2 RAPID Problem Description Form

Name: Phone:
Company: FAX:
Address: e-mail:

City, State & Zip Code:

Problem Description:

FAA Use Only

Date Received: Date Validated: Date of Response:
Problem Source (Circle One)

Application
Documentation
Hardware
System Software
Other:

Module Affected: Date Fixed/Incorporated:

Final Disposition:
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6. Installation

6.1 Run Setup

Exit all other Windows programs, insert Disk 1, and then run the set up program. Setup can be
run by double-clicking the icon or by entering the following command at a DOS prompt or in a
“Run...” dialog.

a:\setup

If a previous version of RAPID is already installed, then user created models and data files
should first be backed up, and then the previous version of RAPID should be uninstalled or
removed. Older versions of RAPID which do not include an uninstall utility can be removed by
simply deleting the RAPID directory and its contents. Please note that repair configuration data
files generated by older versions of RAPID may not be compatible with the current version.

After a few moments, the following dialog will appear. Select the Next button to continue.

Welcome

YWelcome to the BAPID Far Commuters 1.0 Setup
program. T hiz program will install BAPID Faor
- Commuters 1.0 on pour computer.

It ig gtrongly recommended that pou exit all wWindows programs
before running thiz Setup program.

Click Cancel to quit Setup and then cloze any programs pou
have mnning. Click Mest to continue with the S etup program.

WAARMIMG: This program iz protected by copenght law and
international reaties.

IInauthonzed reproduction or distibution of thiz program, or any
portion of ik, may result in zevere civil and criminal penalties, and
will be progecuted to the masimum extent poszible under lav.

Cancel |

11



6.2 Choose Destination Location

Chooze Destination Location |

Setup will install BAPID Far Cammuters 1.0 in the following falder.
T o inztall ta this folder, click Nest.

To install to a different folder, click Browse and zelect another
folder.

Y'ou zan chooge not ta install BRAPID For Commuters 1.0 by
chcking Cancel to exit Setup.

" Destination Folder

C:\RapidC Browse. .. |
Cancel |

To install RAPID in the default C. \ Rapi dC\ directory, select the Next button. To install
elsewhere, select the Browse button and enter an alternate directory location.

< Back

When installing from disk, a dialog will appear which will prompt the insertion of the next disk.
Simply remove the current disk, insert the requested disk, and press the Enter key on the
keyboard.

12



6.3 Complete the Installation

The following dialog will appear to verify that the installation of RAPID is complete. Click the
OK button to exit the installation procedure. Remove the remaining disk from the floppy drive
and store the disks in a safe location.

Setup Complete |

Setup has finished installing BAPID For Commuters 1.0 on waur
computer.

¥ ifes, | want to view the Feadie File

¥ ‘es, Locate Adobe Acrobat Feader ta view the b anual

Click Finish to complete Setup

< Hack I Finizh I

The RAPID program may then be run by double-clicking on the installed RAPID FOR
COMMUTERS 1.0 program icon. In Windows 95, 98 and Windows NT 4.0, RAPID may also
be run by selecting it from within the Programs section of the Windows Start button.

13



6.4 Change to 1024 by 768 mode (recommended)

Although it is possible to use RAPID with any Windows-compatible display, it is recommended
that a minimum window resolution of 800 by 600 dpi be used so that the windows will fit the
display without the use of scrolling. However, 1024 by 768 or higher provides space to easier
work on multiples configurations. For Windows 95, 98 and Windows NT 4.0, please refer to the
hardware and operating system documentation included with the computer. Typically, the video
mode can be changed through the Settings tab on the Display Properties, accessible from both
the Control Panel, or by clicking the right mouse button on the Windows desktop and then
selecting Properties.

14



6.5 Program Setup

RAFID For Commisiers

Figure 6-1

6.5.1 File Locations

RAPID Setup [ x|

— File Locations:
Files: Location

Data C:\Rapid
Temp C:%Rapid
Loads/S tress C:\Rapid

b odify... |

—Adobe Acrobat Beader -- for Dizplaying M anual

Frogram Mame and Location:
C:AProgram Filezt\Adobehdcrobat 4.00F eadertAcroR d32 exe

Cancel

Figure 6-2

The data in this dialog can only be changed by the Administrator.
This dialog is accessed from the menu bar with File | Program Setup | File Locations.

The file locations are originally determined at the time of the installation. These locations can be modified by
selecting the File to be changed. Mouse click on the “Modify...” button to choose a new Location (subdirectory).

15



At this time, the Adobe Acrobat Reader must be entered by the user. The program will attempt to locate the Adobe

Acrobat subdirectory. But, because there are so many naming conventions, the user must use the “Browse” button to
select the correct executable.

It is used to display and print the this Manual.
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6.5.2 Generate Commuter Load Spectrum

Commuter Load 5pectrum

Dezcription

File Mame [hao directary] ITest_Ln:nads.dat

— Properties

. . Cruize Speed
Flight Distance |2':|4 [knntg] |24EI

% Mautical Miles & Equivalent Airzpeed
" Statute Milez ' True Sispeed

Drezign M a=imum T ake-off YWeight [lbs] |1 G300
YWing Area [zq ft] 450

Cruize Altitude [ft] ISDEIEIEI

b asimnum Dezigned Cruize Altitude [ft] ISEDEIEI

Marminal Mazimum arking Pressune [psi] |9.3

Sellizeli Delete |

] I Cancel | Help

Figure 6-3

The data in this dialog can only be changed by the Administrator.
This dialog is accessed from the menu bar with File | Program Setup | Generate Commuter Load Spectrum.

It must be used if the user is going to utilize the capabilities in RAPID with respect to commuter load spectra. This
will generate the load spectrum that is used later to generate the stress spectra and if required the equivalent stress.
Any load spectrum created will be stored in the directory where RAPID resides.

To Add a new spectrum:
1. Start typing in the Description edit field.
2. Give the new spectrum a File Name (no directory --- the program File Locations places it in the correct
subdirectory).
3. Add the properties (using the limits listed below);

The input parameters to generate a commuter load spectrum are as follows:

1. Flight Distance (Miles) ---- Minimum: 1.0 nautical miles, Maximum: 2,500 nautical mile
a. Nautical Miles
b. Statute Miles ---- 1.0 statute mile = 0.8684 nautical mile

2. Cruise Speed (Knots) ---- Minimum: 50 Knots (true airspeed), Maximum: 500 Knots (true airspeed)
a. Equivalent Airspeed ---- program will calculate the true airspeed with given cruise altitude.

17



b. True Airspeed
Design Maximum Take-off Weight (Ibs.) ---- Minimum: 4,000 Ibs., Maximum: 19,000 Ibs.
Wing Area (sg.ft.) ---- Minimum: 150 sqg.ft., Maximum: 450 sq.ft.
Cruise Altitude (ft.) ---- Minimum: 100 ft., Maximum: 45,000 ft.
Maximum Cruise Altitude (ft.) ---- Maximum 45,000 ft.
Nominal Maximum Working Pressure (psi) ---- Minimum: 0 psi, Maximum: 10 psi

Nogs~®

To Edit a Commuter Load Spectrum; select a spectrum from the Description combo box. Make the appropriate
changes in the Properties edit fields. Mouse click the Edit button.
NOTE: If you want to change the File Name; you first must delete the spectrum; then create a new spectrum.

To Delete a Commuter Load Spectrum; select a spectrum from the Description combo box. Mouse click the Delete
button.

18



6.5.3 Generate Transport Load Spectrum

Transport Load Spectrum

— Generate Load Spectrum

[T Generc Marow Body Generate |

[T Generic ‘Wide Body

Cancel |

1033 MB available an hard dizk ﬁl

0 MEB required

Figure 6-4

The data in this dialog can only be changed by the Administrator.

This dialog is accessed from the menu bar with File | Program Setup | Generate Transport Load Spectrum.

It must be used if the user is going to utilize the capabilities in RAPID with respect to transport load spectra. This
will generate generic narrow body and wide body load spectrums that are used later to generate the stress spectra

and if required the equivalent stress.

The Wide Body spectrum needs 20MB and the Narrow Body spectrum needs 9MB.

19



6.5.4 User Table

Uszer Table

" Usercode Desciption Password
Supervizar Administrative passvvord
ouiest Guest User passvvord

ra | =

]
aq
5
=]
v
g
9
1

1]

=

Cancel Inzert Fow Add Row ElearHle |Delete Fh:uq Help |

Figure 6-5

This table is for use by the Administrator Only.
NOTE: The Supervisor Password needs to be changed after receipt of the program

Usercode --- up to 12 alpha numeric characters

Description --- up to 25 alpha numeric characters

Password --- up to 10 alpha numeric characters

Access --- 1 is Administrator level --- can make changes in the Program Setup. 2 is User level --- has read only to
the Program Setup

Insert Row --- Select the row that you want to Insert Row ahead.
Add Row --- Select the row that you want to Add Row after.
Clear Row --- Clears a row of all entries.

Delete Row --- Delete a row.

The changes are not saved until OK is clicked. Cancel will return the User Table to its last saved state.

20



6.5.5 Program Defaults

Defaults [ x|

— Propertiesz
Skin Material |2I]24-T3 Clad Sheet

Skin Thickness |
Layer kd aterial |2I]24-T3 Clad Sheet
Laver Thicknesz 0.071 -
Faztener Style IN.-‘-‘-.51 097-E

Faztener Diameter IEI.1 avs *I

— Fastener Arangements
Diameter 018745

Langitudinal Pitch
Circurmferential Fitch
Longitudinal Edge Distance 0.5

Circumferential Edge Distance 0.5

Cancel

Figure 6-6

The data in this dialog can only be changed by the Administrator.
This dialog is accessed from the menu bar with File | Program Setup | Program Defaults.

This dialog allows the administrator to set default values for various design details that are utilized in the repair.

21



6.5.6 Organization / Company Info

Orgamzation / Company Hame E

Organization IWE Do Frepairs
Company Mame

Addiess |12345 Wardlow
Address |Suite 304

City IL::ung Beach

State IDE'. Zip IEIEIBEIE

Contact I-Jl:uhn Doe
Phone [562-555-1214

| aF. I Cancel

Figure 6-7

This dialog is accessed from the menu bar with File | Program Setup | Organization/Company Info.

This dialog allows the administrator to record the Organization / Company Info , some of which will be used on
the Report.

22



6.5.7 Proprietary Statement

Proprietary Statement

[Statement - 2

Statement Dezcription

IStatement -1

fdd / Edi Delete |

Statement 1 can be used for Antenna Installations. =]

Enter statement iz this area. Thiz statement will
appear on the reports first page under the General
[nfarmation

k. I Cancel

Figure 6-8

The data in this dialog can only be changed by the Administrator.
The Proprietary Statement is used as a field in the Report. It is not a required field.
The first time this page is used, sample statements will be present.

The top box is a list box containing a list of existing statement descriptions. It is a non-editable field. Picking a
statement in this box will cause the statement information to be displayed in the other 2 edit fields.

The middle edit field is a Description of the statement to be used in the list box above.

The bottom edit box is a multi-line edit field that can be treated as a mini editor for entering the text of the
Statement.

“Add” --- To add a statement, start typing in Description or Statement fields. When finished, “Add” the statement
by clicking on the “Add/Edit” button. The description will be added the list box.

“Edit” --- Only the Statement can be edited, the Description cannot be edited. Make the appropriate changes in the
statement and mouse click on the “Add/Edit” button

To edit the Description, start typing the Description field. When finished, mouse click on the “Add/Edit” button.
This new Description will be added to the box. Then “Delete” the previous Description.

23



“Delete” --- Mouse click on the Description in the top list box; then mouse click the “Delete” button.

24



7. Running RAPID

RAPID is run by double-clicking on the installed RAPID For Commuters 1.0 program icon.
RAPID may also be run by selecting it from within the Programs section of the Windows Start
button. When opened, RAPID fills the screen with the RAPID Multi-Document Interface
(MDI). Commonly used tools and options are available both from the icon button bar and from
the pull-down menus. Other options are available only from the pull-down menus. As with most
Windows applications, the pull-down menus can be accessed both by mouse selection and by
holding down the “Alt” key then pressing the key-character of the menu item. (The key-
character is underlined.) For use with a mouse, however, selection is simplified by the icon
button bar. Each button represents a selection available in a pull-down menu. As the mouse
pointer is placed over any of the buttons, a description of the button is displayed in the strip
along the bottom of the RAPID MDI window.

The following figure shows an example of the RAPID MDI with several of the input windows
opened.

7.1 Logon Screen

25



The first dialog that appears is the Logon. A guest user can logon with a Username of “guest” (without the quotes)
and a Password of “password” (without the quotes). Other Usernames can be added through the File | Program
Setup | User Table dialog by an administrator.

7.2 Opening Window

™ Da not chow thic 1o sy e P opern

Figure 7-1
After the Logon is complete, the user makes chooses New Design, Open Existing Design, or Cancel.

If the user wants to turn off this screen, check the “Do not show” box. In the future, the user will use the standard
Windows File | New or File | Open menu items.

This feature can be turned back on by going to the Help Menu and clicking on the “Show Opening Screen”.

The opening window displays the RAPID Multidocument Interface. All other windows in the RAPID system are
selected from and displayed in this window. The Statusbar (gray strip along the bottom) describes the function of
each button as it is pointed to by the mouse. The Statusbar also gives hints for entries throughout the program

The Toolbar (icon buttons near the top of the window) activates most of the capabilities within RAPID. In every
case, their functions are reproduced by selections within the pull-down menus located on the line above the button
bar. The icon buttons perform the functions listed below. The bold face entries are documented within this section.

26



LJ

0 & M &

Starts a New repair.

Opens an existing repair file.

Saves the current repair to a file.

Copies the current window to the Windows clipboard.
Prints the current window.

Activates the Design property sheet.

Activates the Analysis property sheet.

Activates the Report property sheet.

Invokes the on-line Help system.

27



7.3 Opening Design

Tapsd - Uriedad_2
Fin [t bws Demgm o0 S iedow Help
O 5D n ¥

= liried

Fiod g passat F1 el

After choosing either the New or Existing Design, the user will be presented with a “Design” Property Sheet
containing the following pages: Structure, Configuration, Skin, Cutout, Frames, Longerons, Materials, and
Geometry.

After the Structure page is completed and “Applied”, the next page becomes available.

The pages are disabled to force the user to complete the design in a logical way. As each page is completed and
“Applied”, the next page becomes available. Mouse click on the next page to activate it.

“Apply” saves the data in a temporary file. “Close” will also save the data; but will close the “Design” Property
Sheet as well.

If all the required input is not provided then the program will inform the user what is missing and not activate the
next page

NOTE:
As the user progresses through the pages, changes sometimes have to be made on a
previous property sheet or pages. If a change is made, the program advises the user which
pages must be modified or Re-Applied.

28



7.4 Design Property Sheets

=5 Rapid - test2_rpd
File  Edit Wiew | Design AStalvzi:  Heporf  WWindow
[l = E | Eg Structure... F‘

= Configuratior...
i C:\Rapiditg Skin Properties. .

Fasteners: Cutavt Infa...

Types: Frame Info
-- Critical .
- H&ASIO Longeron [nfa...
Mominal Pitch Matenials... Longetot —- 3
Longitudinal Geometmy...

Figure 7-2

This activates the Design Property Sheet containing the pages to create a design. On a new design, only Structure
will be available; the other choices being “grayed out”.

On an existing design, the user can use the menu to navigate rapidly to a particular page.

29



7.4.1 Structure

[ Beta_Extl.rpd : Design M= B3

1 - Structure | 2 - Canfiguration I 3 - 5Skin I 4 - Cutowt I B-FA I FI

— Type
" Comriuter

" Ankenna Installations

' Fuselage Skin Fepairs

Close Cancel | Apply | Help

Figure 7-3
The user selects the design type from the Structure page. This tells the program how to format the subsequent pages.
After the Structure page is completed and “Applied”, the Configuration page becomes available.

The pages are disabled to force the user to complete the design in a logical way. As each page is completed and
“Applied”, the next page becomes available. Mouse click on the next page to activate it.

“Apply” saves the data in a temporary file. “Close” will also save the data; but will close the “Design” Property
Sheet as well.
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R apid

& Applicable Antenna |nstallations Include:

-A0F [12" long by 6" wide by 1" tall]
-GPS (4" by 4" by 0.5"]

-Tranzponder and DME [5* by 2 byp 10"
-TCAS

Figure 7-4

If Antenna Installations is selected and applied, the user will be presented with the above message box showing
which kind of installations are applicable with this version.
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7.4.2 Configuration

There are 2 basic types of Configuration pages. The first type is for Antenna Installations

7.4.2.1 Antenna Installations

[ test?_rpd : Design M= E3

1 - Stucture 2 - Configuration I 3- Skinl 4 - Eutu:uutl -FA I 4 I

Antenna Installation Configurations ;
' Fectangular [includes square}
& Circular

) Elliptical

*= b grimumn Mounting Plate Layers iz 1

Conzider Stiffener [Eareder Bulging
[ Effectz r Effects

Mourting Bofts

o o o o o O

fO O O 0O O O

Cancel | Apply | Help

Figure 7-5

The next item in the sequence for Antenna Installations is type of Configuration for the design. The user will
determine which configuration to use and whether the select Consider Stiffener Effects.

After the selections for the configuration are “Applied” then the Skin page is active.
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7.4.2.2 Fuselage Repairs
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Figure 7-6
The next item in the sequence for Fuselage Repairs is type of Configuration for the design.

This window is used to select among the supported fuselage repair types. For the repair type selected, a generic
schematic of the cross section is depicted within the window. Currently, nine repair types are available, as depicted

in the following figure:
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The user will determine which configuration to use and whether the select Consider Stiffener Effects.

After the selections for the configuration are “Applied” then the Skin page is active.
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7.4.3 Skin

7.4.3.1 Common Repairs and Antenna Installations
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Figure 7-7

The next item in the sequence is the cutout in the skin. Here the dimensions of the cutout are input, then "Applied"

After the selections for the configuration are applied then the Skin page is active. On this page the material and
thickness of the skin is determined
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7.4.3.2 Complex Repairs — Butt and Lap Joints
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Figure 7-8

This dialog window is used to define the material properties of the skins and joint, and is manually invoked by
clicking with the right mouse button on a skin or joint or by selecting the toolbar icon. If the current Configuration
contains more than one skin or also contains a joint, then the properties for each of those layers must be defined
before the window may be closed with the Close button.

For repairs over splice and butt joints, the geometry must be entered as indicated in the displayed drawing. This
dialog window will display only those fields which are appropriate for the current repair type.

There are different limits as enters are made. The program will advise the user when those limits are violated, and
will make suggestions for entries.

The Close button updates the current model with any information entered in the window and then closes the

window. The Cancel button exits the window without saving any new entries. Finally, the Help button retrieves
help appropriate to this window.
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7.4.4 Cutout
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Figure 7-9

The next item in the sequence is the Cutout in the skin. Here the dimensions of the cutout are input, then
"Applied".

In the current version, only a single layer of skin may be cutout, except for the type 8 double lap joint repair which
has two overlapping cutouts in the skin lap joint.

There are different limits depending on the type of Configuration. The program will advise the user when those
limits are violated, and will make suggestions for entries.

The Close button updates the current model with any information entered in the window and then closes the

window. The Cancel button exits the window without saving any new entries. Finally, the Help button retrieves
help appropriate to this window.
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7.45 Frames
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Figure 7-10

The frames (stiffeners) around the installation require definition. This is used to identify the location on the design.
A minimum of two frames (stiffeners) is required. If Consider Stiffener Effects is checked in the Configuration
page then the last five fields are active, otherwise they are “grayed” out.

More than 2 frames (stiffeners) can be defined, by increasing the Number of Frames.
As the number is increased, the Number List Box is automatically changed to reflect the total Number of Frames.

The drawing at the bottom of this page indicates where measurements are taken.

Each frame (stiffener) has the following required entries and must be defined:
. Select the Number to be defined.
2. Indicated whether it is above or below the Center Line. If it is on the Center Line; pick either one, as the
Distance will be set to 0.
3. Enter an ID for the frame; usually identified by using the aircraft schematic location.
4. Enter the Distance from Center Line. Limits are 0.0 to 100.0 inches.
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If Consider Stiffener Effects is checked on the Configuration page, the following are required entries:
1. Average Pitch on Frame. Limits are 0.5 to 2.0 inches.
2. Fastener Offset from Center Line. Limits are 0.0 to 1.5 inches.
3. Cross-Sectional Area. Limits are 0.1 to 2.0 in?
4. Select the Frame (stiffener) Material

Repeat the process for each frame (stiffener).
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7.4.6 Longerons
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Figure 7-11

The longerons around the installation require definition. This is used to identify the location on the design. A
minimum of two longerons is required. If Consider Stiffener Effects is checked in the Configuration page then
the last five fields are active, otherwise they are “grayed” out.

More than 2 longerons can be defined, by increasing the Number of Longerons.
As the number is increased, the Number List Box is automatically changed to reflect the total Number of
Longerons.

The drawing at the bottom of this page indicates where measurements are taken.

Each longeron has the following required entries and must be defined:
1. Select the Number to be defined.
2. Indicated whether it is above or below the Center Line. If it is on the Center Line; pick either one, as the
Distance will be set to 0.
3. Enter an ID for the longeron; usually identified by using the aircraft schematic location.
4. Enter the Distance from Center Line. Limits are 0.0 to 50.0 inches.
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If Consider Stiffener Effects is checked on the Configuration page, the following are required entries:
1. Average Pitch on Longeron. Limits are 0.5 to 2.0 inches.
2. Fastener Offset from Center Line. Limits are 0.0 to 1.5 inches.
3. Cross-Sectional Area. Limits are 0.1 to 2.0 in®
4. Select the Frame (stiffener) Material

Repeat the process for each longeron.
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7.4.7 Material
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Figure 7-12
The Materials page describes the Layer Properties for each layer of the design and Defines Fasteners used in the
design
7.4.7.1 Layer Properties
The Layer Properties lists all the layers in the design except the Skin layer.

Select the appropriate Material and Thickness for each Layer.

7.4.7.2 Define Fasteners

The user specifies the different types and styles of fasteners in the design using the Define Fasteners dialog.
Fastener types are defined by first entering the number of fastener types desired in the Number of Fastener Types
edit field. The Type Number combobox will automatically be updated to reflect the Number of Fastener Types.
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Style and Diameter must be entered for each Type Number:
1. Selecta Type Number.
2. Select a Style to be associated with the Type Number.
3. Select a Diameter for the Style selected.
4. Repeat the process for each Type Number.

7.4.7.3 Change Fastener Types on the Drawing

Fastener Types

Faztener Type -

Style [MAST097-E

Diameter [in] IEI.1 a7h

Figure 7-13

To change fastener types, they must first be defined in the Define Fasteners on the Material page. Any number of
fasteners may be simultaneously changed to a predefined type. Multiple fasteners are selected by click and holding
the left mouse button; then dragging the mouse to draw a rectangle around a group of fasteners. Releasing the
mouse button then toggles the selection state of each of the enclosed fasteners. Subsequently clicking the right
mouse button will invoke the Fastener Types dialog through which the new fastener type may be selected.
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7.4.8 Geometry

[ test?_1pd : Deszign M= E3

5 - Frames I G - Longerons I T -Matenialz 8 - Geometry | 1 I k I

Marminal Diarmeter [all faztensrz] -

— Pitch and Edage Digtances [in]

== BAPID Abzolute Guidelines far Min # Max =
Minimum  Mominal B asinum
[ Dviamn] [inzh] [ Driam]

Longitudingl Fitch {075 [1 [15
Circurnferential Pitch |1 75 I [1.5
Longitudingl Edge 025125 [05 [0.75
Circurnferential Edge [025125 {05 [0.75

R anges:

— Fastener Rows Per Side
FOUNT - Mounting Plate

Left of Cutout |3 it af St |3
Top of Cubout |3 B it af Eotat |3

— Laver Location / Dimehzions:

kounting Flate 2in. % 3 in.

o to Analysiz
FPhase

Close Cancel | spply | Help

Figure 7-14
The Geometry page provides the input for the Nominal Pitch, Pitch and Edge Distances, Fastener Rows per Side.
The dimensions of the design layers are displayed near the bottom of the page.
After “Applying” the geometry, mouse click the “Close” button to close the Design property sheet.
Mouse click the “A” on the tool bar to activate the Analysis property sheet.

The Nominal Diameter defaults to the Type 1 fastener defined in the Material page. The Nominal Diameter is
used to established the Pitch and Edge min/max values from the Advisory System.

Pitch and Edge Distance:
Under the Pitch and Edge Distance (in) section of the dialog window, the user specifies the pitch and edge
distances of the fasteners, which otherwise default to the settings selected in the program setup. These values are

bound by the min/max values stored in the Advisory System as determined by the nominal fastener diameter. In
models with stiffener effects and/or joints with existing fasteners, the pitch is fixed to that of the existing fasteners.
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Fastener Rows Per Side:

Each layer, other than the Skin, must have fastener rows defined:

1. Select a Layer.

2. Enter the appropriate number of rows for each side of the cutout. Some of the edit fields may not be
accessible. This could be that the design does not call for a row of fasteners or the design is symmetrical; in
which case, the program will automatically enter the rows necessary. Use the guidelines shown in the
figures below. Rule of thumb: For 2 layers on the same side of the skin, the layer closest to the skin will
always have an extra row of fasteners. An internal layer will always have a extra rows of fasteners, if used
with an external layer.

3. Repeat the process for each layer.

Fastener Row limits vary by type and configuration. Limits are 1 to 5; the program will give hints on the status bar.

Fastener Row Examples:

For repair type 1, the internal doubler should be larger than the external doubler. The internal doubler should be
sized such that the single outermost fastener row passes through the skin and the internal doubler as shown in the
figure below.
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For repair type 2, the external doubler 2 (inner) should be larger than the external doubler 1 (outer). The doublers
should be sized such that the single outermost fastener row passes through the skin and the external doubler 2 (inner)
as shown below.
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7.5 Analysis Property Sheet
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Figure 7-15

This activates the Analysis Property Sheet containing the pages to create a design. On a new design, only Airplane
Data will be available; the other choices being “grayed out”.

On an existing design, the user can use the menu to navigate rapidly to a particular page. In this example, the

existing design did not call for Consider Proximity Effects in the DTA Options page, so the Proximity page
remains unavailable
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7.5.1 Airplane Data
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Figure 7-16

This is the first page of the "Analysis" property sheet. The pages contain are Airplane Data, Location, DTA
Options, Load/Stress, Proximity Data, Run Analysis, and Results.

The Airplane Data is used to determine the type of airplane and whether RAPID can supply spectrum data for the
Load/Stress page to use to calculate equivalent stress.

If RAPID can’t supply the spectrum data, the user is advised to provide a stress spectrum or equivalent stress.
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7.5.2 Location
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Figure 7-17

The Location page is where the user defines where the design location resides on the fuselage. The Transport dialog
is shown below.

This window is used to define the location of the damage on the aircraft in relation to several pre-defined regions,
which may be viewed by drawing at the bottom of the page.

This input is used to when calculating the equivalent stress at the design location.

Select the Zone in which the design location resides.

Enter the total distance for the Zone in Length “S” of Zone

Enter the distance from the front of the Zone to the design location in Distance “L” on Zone map
Enter the distance from the Distance “D” on Zone map

Enter the Fuselage Radius Near Design Location

abrwbdE
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The Close button updates the current model with any information entered in the window and then closes the
window. The Cancel button exits the window without saving any new entries. Finally, the Help button retrieves
help appropriate to this window.
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7.5.3 DTA Options
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Figure 7-18

The DTA Options page provides options for the damage tolerance analysis.

It is recommended to use the Simplified Method (equivalent stress method) initially instead of the cycle by cycle
method. The cycle by cycle method will take hours to run. The equivalent stress method will provide answers
approximate to the cycle by cycle method but much faster. If the equivalent stress results are not adequate then the
user should use the cycle by cycle method.

Proximity effects are currently only available for Common Fuselage Repairs
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7.5.4 Load/Stress
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Figure 7-19

The Operating Pressure is used to define the limit load condition. User input is required if User Defined
Equivalent Stress or User Defined Stress Spectrum is selected. See section 3 and the Analysis Methods
Document for further details on the limit load condition

The Load/Stress page is where the load and stress information is input.

After “Applying” the input, the program may run a fortran dll to calculate the equivalent stress. The message bar at
the bottom of the program window will indicate if this is happening. The fortran dll only runs for a minute or two.

This dialog window is used to select the stress spectrum applied during the damage tolerance analysis. The
Equivalent Stress defines the constant stress amplitude at the repair location. See section 3 and the Analysis
Methods Document for further details on the equivalent stress. If the equivalent stress is supplied, then the other
input fields are not used. Otherwise, the Stress Spectrum is selected from one of the RAPID Defined spectra or
from a User Defined file.
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User Defined Stress Spectrum (ascii) must be in one of the two following ASCII text file formats. Examples of
these files are included with the RAPID distribution as PSEUDO. SSF and CYCLES. SSF for pseudo-flights and

cycle-by-cycle, respectively. These are only examples of the input format; they are not intended to be used as test
files.

1. Pseudo-Flights (in repeatable flight sequence)

mtype

mflt

ifltseq, ifltseq;, ifltseqs ... ifltseqmat

mcyc;

Smin;  Smax; Smin, Smax, SMiNmeyer SMaXmeye1
mcyc;

Smin; Smax; Smin, Smax, SMiNmeyc1 SMaXmeyc2

mcycmtype
Smin; Smax; Smin, Smax, .. SMiNmeyc1 SMaXmeyemtype
where mtype is the number of different flight types specified (maximum=20)
mflt is the number of flights in the spectrum (maximum=6000)
ifltseq contains the sequence of the flight types
mcyc is the number of cycle pairs for the flight type (maximum=21000)
Shin IS the minimum stress
Shhax 1S the maximum stress
2. Cycle-by-Cycle Stresses (in repeatable block)

mflt

mcyc,

Smin;  Smax; Smin, Smax, SMiNmeye1 SMaXmeye1
mcyc,

Smin;  Smax; Smin, Smax, SMiNmeye1 SMaXmeye2
mcycmtype

Smin; Smax; Smin, Smax, SMiNmeyc1 SMaXmeycmtype

where mflt is the number of flights in the spectrum (maximum=6000)
mcyc is the number of cycle pairs for the flight type (maximum=21000)
Spin IS the minimum stress
Smax IS the maximum stress

For the user defined spectrum, Rainflow Counting and Range Truncation Level must also be specified, as
documented in the Analysis Methods Document.

The input is parsed by RAPID according to the following flow chart:
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I |
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Figure 7-21
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7.5.5 Proximity Data
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Figure 7-22

This page is for input of the proximity data and is only available if Consider Proximity Effects was checked on the
DTA Options page. Proximity Effects are currently only available for Common Fuselage Repairs

The Proximity Data is used to define the size and location of a nearby repair so that its influence may be considered
in the analysis.

The location of the nearby (proximity) design is indicated by selecting a reference fasteners in both the subject and
proximity designs in the Reference Fastener Locations box.. This is done by selecting the quadrant where the
reference fastener is located. You can use the quadrant combo boxes or you can mouse click in the quadrant on the
pictures. The picture at the bottom of the dialog page will update as you make you selections, helping you to
visualize the relationship.

The geometry of the nearby (proximity) design can be entered directly under the Proximity Design Geometry

section. Enter the overall size of the proximity repair and the reference fastener edge distance for the proximity
design.
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The Reference Fastener Distances between the Subject reference fastener and the Proximity reference fastener are
entered in the Ax and Ay using the given formulas. Always remember that these distances are really the relationship

of the proximity repair to the subject repair. Negative numbers are permitted as indicated in the picture at the bottom
of the dialog page. Positive and negative numbers will change the picture accordingly.
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7.5.6 Run Analysis
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Figure 7-23

On this Run Analysis page, the user can review the analysis input files.

The user decides which Analyses to run by checking the appropriate boxes, and indicating whether to be notified
after the Static Analysis has completed. The Run button becomes available after checking a box(es). Depressing
the Run button starts the Fortran DLLs. The dialog box below opens to indicate which analysis is running and when
it started. Once the analysis finishes, the elapsed time is recorded under the Run button.
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Figure 7-24

This dialog box indicates to the user that the analysis is running and the time it started

The Cancel button stops the analysis. HOWEVER, the user will be advised that computer memory is probably
corrupted and should reboot the computer.

The source of this problem is still being investigated; use the Cancel button only as a last resort.

59



Untitled_1 : Static Analysis Results
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Figure 7-25

The output can be displayed by selecting the Tabular Results on the Results page.

From the static analysis, the margins of safety (MS) based on the repair doubler allowable and the fastener joint
allowables are calculated to determine the adequacy of the repair as follows.

MS < 0: Repair is statically inadequate

MS = 0: Repair is marginally adequate

MS > 0: Repair is statically adequate
For repairs that are statically inadequate and marginally adequate, the repair should be redesigned.
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7.5.7 Results

= test? rpd - Analysis

3-DTA Optionz I 43 - Load/Stress
1 - Awrplane Data I 2 - Location
Ay - Brawmti Lata I 5 - Bun Analysis G - Resultz

— Static Analyziz

Yiew T abular Hesults

Ewmnrt et Hesults |

— Damage Tolerance Analysis

Yiew Tabular Results |

Exmarh et Hesults |

Wiew Crack Growth Plat |

"iews Residual Strength Plot |

Go to Report
FPhasze

Close Cancell Apply I Help I

Figure 7-26

From Results page, the user can review the Static Analysis and Damage Tolerance Analysis Output in both
Tabular and Plot form.
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7.5.7.1 Static Analysis Tabular Results
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Figure 7-27

This window displays the Static Analysis Output from the damage tolerance analysis for all four sides of the repair.
This window can be invoked from the Analysis | Results page.

To print this data, select the print button on the icon bar, or select the Print menu item within the File menu. The

Static Analysis Output window must be the active window to be printed. The user can also Copy this window to
the Windows clipboard for inclusion into another document --- Pasted.
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7.5.7.2 Damage Tolerance Analysis Tabular Results
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Figure 7-28

This window displays the Damage Tolerance Output from the damage tolerance analysis for all four sides of the
repair. (For a symmetrical repair, only sides 2 and 3 are available). This window can be invoked from the Analysis
| Results page.

To print this data, select the print button on the icon bar, or select the Print menu item within the File menu. The

Damage Tolerance Output window must be the active window to be printed. The user can also Copy this window
to the Windows clipboard for inclusion into another document --- Pasted.
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7.5.7.3 Crack Growth Plot

W best? ipad - Crack Geosth Phes
Crack Growth Life Plot - Side 2
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Figure 7-29

This window displays the crack length versus number of flights plot from the damage tolerance analysis for all four
sides of the repair. (For a symmetrical repair, only sides 2 and 3 are available.) The predicted crack growth life at
each of the critical fasteners is indicated in the legend key. This window can be invoked only from the Analysis |
Results page. The plots can be generated for longitudinal cracks in the center and corner fasteners above and below
the cutout and for circumferential cracks in the center and corner fasteners to the left and right of the cutout. If there
are four points, then the plot will not be generated and a message box will be displayed.

The user can choose which side to view. If there is insufficient data to produce a Plot, the user will be notified with
an appropriate message.

The crack grows edge to tip and then tip to tip as defined in the figure below.

Initial Flaw Q Q 8—%

Crack Grows
Into Hole

Edge-To-Tip Crack Length

Tip-To-Tip Crack

To print the plot, select the print button on the icon bar, or select the Print menu item within the File menu. The
Plot window must be the active window to be printed. The user can also Copy the Plot to the Windows clipboard
for inclusion into another document --- Pasted.
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7.5.7.4 Residual Strength Plot
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Figure 7-30

This window displays the residual strength versus crack length plot from the damage tolerance analysis for all four
sides of the repair. (For a symmetrical repair, only sides 2 and 3 are available). The yield strength of the skin, Fy, is
indicated by the solid horizontal line and the Load Limit is indicated in the legend key. This window can be
invoked from the Analysis | Results page. The plots can be generated for longitudinal cracks in the center and
corner fasteners above and below the cutout and for circumferential cracks in the center and corner fasteners to the
left and right of the cutout. If there are less than four points, then the plot will not be generated and a message box
will be displayed.

The user can choose which side to view. If there is insufficient data to produce a Plot, the user will be notified with
an appropriate message.

To print the plot, select the print button on the icon bar, or select the Print menu item within the File menu. The

Plot window must be the active window to be printed. The user can also Copy the Plot to the Windows clipboard
for inclusion into another document --- Pasted.
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7.6 Report Property Sheet

=5 Rapid - test?_rpd

File  Edit Wiew Desigh Analysiz | Beport Window  Help
D= & B & D A | Abwaftinf.
Surnmary [nfarmatior...
Beport. .

= C:\Rapiditest?.rpd : Drawin

Fastenera:

Tres
‘§-- Critical fasteners
- M&31097-E, Dia=0.1875

Figure 7-31

This activates the Report Property Sheet containing the pages to create a design. On a new design, all pages are
initially available, as these pages only affect the Report.
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7.6.1 Aircraft Info

= Beta_Ant1_rpd : Report M= 3
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Design |D |532IIIIII-IIIEI1 Rew IN B

Bart HameMumber

Fuzelage Skin between station 23 and station 24 =
and ztringer L4 and stringer LS. Part number ||
Comment
-
I
Close Cancel | Apply. | Help |

Figure 7-32

This page collects the information used for the first page of the Report.

If no information is supplied for a particular field, the entry “No information supplied” will appear on the Report for
that field.
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7.6.2 Summary

= test?2rpd : Report

1 - Aircraft Infa 2 - Summary I 3 - Repart I
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Jusgtifications

E
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Close Cancel | Apply. |

Figure 7-33

This page allows the user to supply more information for the Report.

If no information is supplied for a particular field, the entry “No information supplied” will appear on the Report for
that field.

The bottom 4 fields are multi-line edit fields to be used as mini editors. The maximum number of characters for each
of these fields is limited to 512 — including spaces, punctuation, and carriage returns.
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7.6.3 Report

= Typel.pd : Beport
1 - Airzraft [nfa I 2 - Summary 3 - Hepart |

5 rigtary Statement:
Y Hon

Statement - 1
Statement - 2

— FReport Dizplay Options:
~ Filez:
¥ Static Analysis Input
v Damage Tolerance |nput

Output files are alwaps included

— Plots:
¥ Fesidual Strength wz. Crack Length
W Crack Length vs. Crack Growth Life

— Mizcellaneous;

¥ Show Equations and Sample Calculations

Yigww Bepart | Frint Repart |

Close I Cancel | Apply. | Help

Figure 7-34

This page allows the user to choose which additional items will appear on the Report.

Select Proprietary Statement allows the user include a statement on the Report. Picking <None> bypasses the
printing of the statement. Statements can be added in using any of 2 methods --- (1) Double-click the right mouse
button in the Statement Box will bring up the Proprietary Statement Dialog. (2) The Proprietary Statement
Dialog can be accessed directly by choosing the File | Program Setup submenu.

The View Report allows the user the check the Report prior to printing. It also provides the user with the ability to
save the Report for inclusion in another document. Printing the Report from this view will NOT include the
Drawing and Plot views.

The Print Report sends the Report to the printer and “attaches” the Drawing and Plot views to the end of the
Report.

Changes in the Report options disables the View Report and Print Report buttons until the user Applies those
changes.

Close the property sheet by mouse clicking the “Close” button
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9. Appendices

9.1 Appendix A -- Material Database

The Database menu section of the Tools menu contains Materials and Fasteners menu selections, which are
described in the following subsections.

M aternial D atabasze

= BARID Defined Recard **

— eneral Information————— — Shrenagth Properties

= b aterial = Thickness{minfin IEI.EIEEIEI vI
TemperITE Thickness{maz](in’ IEI.EIEEI Cancel |
Surface |Bare Fhu E5
I _ I Help |

Farm |Sheet Fhy ki) 58
Reference Fep 58
|h-1i| hdbk B, table 3.2.1.0 (b1, 1 Mo

el
Fau (ki) a9 [ terial

— Mechanical Properties——————————— Fbru efD=1.5 97 Delet_e
= Youngs Modulug I'IEIEEIEI Fbru 6/D=2 0 13 fiaterial

Poizzon's R atio IEI.33 Fhiy e/D=1.5 8 o
— Fracture/Crack Growth Properties —— Fbry e/D=2.0 8 M

= Flo |83.3 kc [Ielete

\wialker O T EEEe0TD [Plane Strezz Fracture Toughnesz] M

W alker |'15?"93? = da/ o | et e
wialker [3.78308 | Browse |

Figure 9-1

This window is used to review and add to the database of materials available for analysis. There is no icon button
on the button bar of the main RAPID MDI window for this dialog window; it must be opened from the Database
menu item in the File menu.

The text in the upper right of the dialog indicates whether the current material is a RAPID-defined record or a user-
defined record. To add new a new material or material properties, just start typing in the Material, Temper, or
Thickness box. This will clear the entries to allow user-defined data to be entered, which can then be saved by
selecting the Add Material button or discarded by selecting a RAPID defined material or the Cancel button. To
edit a user defined material, type the change and depress the Add Material button. The OK button closes the
window.

Only user-defined records can be deleted with the Delete Material button. The Delete Strength button only deletes
the entries for a particular Thickness.

The terms are defined as follows:
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K. = Plane strain fracture toughness
C, g, p =Coefficients of the Walker crack growth rate equation
da p
o d@-R)"K,.
where
Kmax = the stress-intensity factor associated with the maximum stress in the stress
spectrum.
Fw = Allowable tensile stress
Fy = Allowable tensile yield stress at permanent strain = 0.002

Fc, = Allowable compressive yield stress at permanent strain = 0.002

Fs, = Allowable ultimate stress in pure shear (this value represents the average shearing stress over the
cross-section)

Fory = Allowable ultimate bearing stress
e/D = Ratio of edge distance to hole diameter
Fory = Allowable bearing yield stress

K. = Critical plane stress fracture toughness, a measure of fracture toughness at point of crack growth
instability

If K, is not present, then it will be automatically calculated using the NASA/FLAGRO 2.0 equation:
K. (A} )P
=1+B,e 0

Ic
where
ty = 2.5 (Ki/Fy )?

When adding a new entry, if the Thickness (min) field is overwritten and then that field is exited by pressing the tab
key or selecting another field with the mouse, then the following dialog window will appear. This allows the user to

choose between adding properties at a new minimum thickness or changing the value of the minimum thickness for
the current record

Material D atabaze

Are vou adding a new Strength Properties
Recard? Select <MO> if pau are changing
the Minimurn T hickness of the curent

record.
Mo I Ear‘u:ell

When the Delete button is selected, the following dialog appears to allow the user to choose between deleting the
entire record or simply the material strength properties for the displayed material thickness.
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<+ Delete entire Material Record

Cancel

b Delete Material Strength Properties record
for thiz Matenial Thickness [min]

9.2 Appendix B -- Fastener Database

Fastener Databasze
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Dezcription I.-'-‘-.Ih:u_lrI Steel Shear Strenth [bs] —

Faztener Maternal Fau [ksi]

Shyle |4 i rT—— Sheet Material/Allowables:

Head Geamety I > - Fluzh b atenial Thicknesz [in] IEI.EISE vI

Jaint Allawable [lbe] for
above fastener diameter 455
Remarkz at thiz matenal thickness

IFIush 1007 zcrew

Feference
IMiI hdbk, 5, tab 8.1.5.2 [al]

Haole |1 - Counterzunk,

k. I Cancel [Nelete Help

Figure 9-2

This window is used to review and add to the database of fasteners available for analysis. There is no icon button on
the button bar of the main RAPID MDI window for this dialog window; it must be opened from the pull-down
Database menu item in the File menu.

The text in the upper right of the dialog indicates whether the current fastener is a RAPID-defined record or a user-
defined record. To add new a new fastener, just start typing in the Type box. This will clear the entries to allow
user-defined data to be entered, which can then be saved by selecting the Add button or discarded by selecting a
RAPID defined fastener or the Cancel button. To edit a user defined material, type the change and depress the Add
button. The OK button closes the window.
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When adding a new entry, if the Fastener Diameter field is overwritten and then that field is exited by pressing the
tab key or selecting another field with the mouse, then the following dialog window appears. This allows the user to

choose between adding properties at a new fastener diameter or changing the value of the fastener diameter for the
current record.

Fastener Database

Are you adding a new Diameter/Shear Strength
Fecord? Select <MO: if vou are changing
the Fastener Diameter of the current recard.

Mo I Eancell

Similarly, when adding a new entry, if the Material Thickness field is overwritten and then that field is exited by
pressing the tab key or selecting another field with the mouse, then the following dialog window appears. This

allows the user to choose between adding properties at a new material thickness or changing the value of the
material thickness for the current record.

Fastener Databaze

Are vou adding a new Sheet M atenial/dlowables
Recard? Select <MO: if yau are chanaging
the Material Thickness of the curent

record.
Mo I Eancell

When the Delete button is selected, the following dialog allows the user to choose between deleting the entire

record, the portion of the data associated with the displayed diameter, or the portion of the data associated with the
displayed material thickness.
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9.3 Appendix C -- DTA Options — Advanced User

= test? 1pd : Analyzis

Aty - Erawimmty et I G- B Snalss I B - Hesulis
1 - Airplane Data I 2 - Location
3-DTA Optionz | A5 LaadlEtess

Crack Growth bethod:

i iSimplified Method [Uses E quivalent Stressk
" Cycle-by-Cycle Method [Uzes Stress Spectmum]

r Print Strezs Intensity Correction Factor in analysis
output

™| Earziden Froximity Effect

— Advanced Optionz:
— Center Hole Optionz - see Help for further digcuzsion
= 1 - Single through crack emanating from a

center hole

2 - Two different cracks emanating fram a

center hole

##* Cee drawing windaw far center hale #*

— Initial Crack Tiplg] [inch]

Primnary Crack, IEI.EIE SecandanErach IEI

[ Enable Retardation [&dvanced User Only)

Close Cancel | Apply | Help

Figure 9-3

The user may select between two Center Hole Options for the crack growth along with a corner
hole scenario, as defined below:

a. Scenario Type 1 (Center Hole) -

C 0.05" O
O O 0.005" C C 0.005"

b. Scenario Type 2 (Center Hole) -
0.005” O 0.05" O

O OO
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C. Scenario Type 3 (Corner Hole) - Always Performed

0.05" O
O O O 005 O——C%ws

For the current version, the program is restricted to assuming a non-visual inspection method.
The crack growth method and retardation flags are set as documented in the Analysis Methods
Document.

The crack growth scenarios are defined as follows:

O O_o.os" O
O O 0.005" O O 0.005"
b. Scenario Type 2 (Center Hole) -

O 0.005" O 0.05" O
C. Scenario Type 3 (Corner Hole) - Always Performed

O O O O 0.05”_0
O O O 0.005”_0—0_0.005”

a. Scenario Type 1 (Center Hole) -

O OO
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9.4 Appendix D -- Description of Analysis Input Files

The RAPID analysis programs are compiled FORTRAN DLL Applications:

Static Analysis - REPAIRS.DLL
Damage Tolerance - REPAIRD.DLL

Both DLLs read “initialization files” — these files contain the input, output, error, and database filenames that are
read by the analysis programs ( the following 2 filenames are hard-coded into the program ) :

Static Analysis - REPAIRS.@#%
Damage Tolerance - REPAIRD.@#%

Obtain the Data
The Static Analysis input is stored in the [~STA_INP] section of the saved repair configuration.

Open the saved file using any ASCII text word processor
Search for [~STA_INP]
Block this section and copy it to the clipboard
Paste from the clipboard to your input file
Example of the start of the section:

NS s

; [ ~STA_I NP]

REPAI R CONFI GURATI ON TYPE (1 External Doubl er)
3

SKI NV DAMAGE : Nunber of Layers

The Damage Tolerance Analysis input is stored in the [~-DTA_INP] section of the saved repair configuration.

Use the above procedure to cut and paste to your document.
Example of the start of the section:

- [ ~DTA_I NP]
4

REPAI R CONFI GURATI ON TYPE (1 External Doubl er)
3
SKIN: Mat. Type

NOTE -- The input decks for both the static and damage tolerance files must NOT contain any blank lines.

The binary stress spectrum files used by damage tolerance analysis can be found by searching for the [~RPD_SP0]
and [~RPD_SP1] sections of the saved repair configuration. The entries in these sections give the files names of the
stored data.

Example of the sections:
; [ ~RPD_SPO]
TYPE31. _SO

; [ ~RPD_SP1]
TYPE31. _S1
These file names are required for the initialization file described below.

Modify the Initialization File
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STATIC Analysis

The static analysis DLL, REPAIRS.DLL, reads the initialization file, REPAIRS. @#$

File specification for REPAIRS. @#$

repairs.inp

repairs. out

repairs.err

/1 input deck created by RAPID GU
/1 output deck created by REPAI RD. EXE
/1 error file created by REPAI RD. EXE

These files can be named anything you wish, the program names them:

repairs.inp

repairs. out

repairs.err

The extension,

<#>

~sta_i np. <#>
~sta_out . <#>
~sta_err.<#>

is an integer the program assigns when it opens a file or starts a

new file.

DAMAGE TOLERANCE Analysis
The damage tolerance analysis DLL, REPAIRD.DLL, reads the initialization file, REPAIRD.@#$

File specification for REPAIRD.@#$

repaird.inp /1 input deck created by RAPID GU

repaird. out /1 output deck created by REPAI RD. EXE

repaird.err /1 output deck created by REPAI RD. EXE

repaird.sif /1 *beta factors for baseline repairs

repai rd. mat /1 *material database factors

repaird. fst /1 *skin stress factors for baseline repairs

1 // flag to indicate the next 2 files are the spectrumfiles to be used

repaird. sp0 /1 binary spectrumfile(circunferential stress)created by RAPID CGU
repaird. spl /1 binary spectrumfile(longitudinal stress) created by RAPID GU
1 /1 flag to indicate the next file is the proximty file to be used

repaird. prx /1 *fastener load transfer factors due to proxinity effect

1 /1 flag to indicate the next file is the splice joint file to be used
repaird.jnt /1 *skin stress factors for splice joint repairs

1 /1 flag to indicate the next 3 files are the stiffener files to be used
repaird. stf /1 *skin stress factors due to stiffener effect

repaird. stb /1 *stiffener beta factors

repaird. | cf /1 *life correction factor database for splice joints

1 /1 flag to indicate the next file is the circular file to be used

repaird.cir /1 *circular repair ratio factors

Note: 0=Do not read filename on next line; 1=read filename on next line.

* Do not change these file names

User may execute analysis with either proximity effect, stiffener effect, or splice joint. These effects cannot be
combined yet. So only one of the flags may be set to 1.

The following files can be named anything you wish, the program names them:

repaird.inp ~dta_i np. <#>

repaird. out ~dt a_out . <#>

repaird.err ~dta_err. <#>

repaird. sp0 ~rpd_sp0. <#> // binary spectrumfile - circunferential stress
repaird. spl ~rpd_spl.<#> // binary spectrumfile - longitudinal stress

The extension, <#>, is an integer the program assigns when it opens a file or starts a new
file.
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9.5 Appendix E -- Description of RAPID.INI File

The RAPID.INI file is used to provide initialization and default data for the application.

It is structured like a generic Windows’ INI file. The text within the brackets [..] is called the “section” and the text
under each “section” are called “entries.” RAPID accesses and updates this file through the Tools | Setup menu.
RAPID is shipped without this INI file. With the initial run of RAPID, an INI file is constructed with hard-coded
data and file location entries on the current drive/directory.

The section/entry names must not be changed!!!

[ Ver si on]
Nurber =2. 0

[File_Locations]

Prog_Di r=D: \ RAPI D2C

Dat a_Di r=D: \ RAPI D2C
Tenp_Di r =D: \ RAPI D2C
Loads_Di r=D: \ RAPI D2C\ LOADS

[ Repai r Type]
Type=TYPE30

ProximityFlag=0 // O-false 1-true
StiffenerFlag=0 // O-false 1-true
LapRever sedFl ag=0 // O-fal se 1-true
[ Report_Options] // parts to be printed on the report
Static_I nput=0 /1 O-fal se 1-true
Static_Results=1 // O-false 1-true
DTA | nput =1 /1 O-fal se 1-true
DTA Resul ts=0 /1l 0O-fal se 1-true
Resi dual _PI ot =0 /1l 0O-fal se 1-true
FI i ghts_Pl ot =0 /1 O-fal se 1-true
I nspection_Plot=0 // O-fal se 1-true
Anal ysis_Notes=0 // O-false 1-true

[ Fast ener _Dat a]
Long_Pitch=1.0
CrcumPitch=1.0
Long_Edge=0.5

Ci rcum Edge=0.5
St yl e=NAS1097- E
Di anet er =0. 1875
Rows=3

[ DTA _Opti ons]

Run_Type=2

Crack_Growt h=1

Hol e_Options=1

Vi sual _Method=0 // O-false 1-true
Ret ar dat i on=0 /1 0O-fal se 1-true
Pri maryTi p=0. 05

Secondar yTi p=0. 0

Oper ati ngPressure=
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[ Stress_Dat a]
Equi vStress=1

11
1
1

Equi vStressVal ue= //

Spect runiJsed=3

Spect runName=Generi c

| nput For mat =1

Rai nFl ow=0
Truncati on=0
TruncRange=2. 0

11
11

/1
11
11
11

1-RAPI D cal cul ated with RAPID data

2- User entered val ue

3- RAPID cal culated with User data

Equi val ent Stress val ue

1- RAPI D defined 2-User defined (binary)
3-User defined (ascii)

Nar r ow Body

1- Pseudo- Flights (repeatable flight sequence)
2-Cycl e-by-Cycl e Stresses (repeatabl e bl ock)
0-fal se 1-true

0-fal se 1-true
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9.6 Appendix F -- Description of Stiffener Effects Reqgions

Damage Tolerance Input File

STI FF

MAX #, PGS, CSA, YNG. MOD, HPI'T

0 0.0 0.0 0.0 0.0

1 1.5 0.5 10500 0. 909

0 0.0 0.0 0.0 0.0

0 0.0 0.0 0.0 0.0

1 26.5 0.5 10500 0. 909

0 0.0 0.0 0.0 0.0
Region0 ®Region 1 ® Region 2 1 Region 3

Fastener
#1

1 % 1

N

0000000000000 000O0
0000000000000 0000

0000000000000000000000O
0000000000 0DPO00000000GO0
00000000000000000000000
000 00000000H00000000A00

00 00
oo'r ' joo

00000000000PO0OO0O00O00O00O00QOO
0000000000000 000000000O0
0000000000 0POOOO00O00OO00O0Q@OO
0000000000000 0000000000

0000000000000000G
0000000000000 000¢

M ] M

Regions -Each repair has 6 regions numbered from left to right:

Region 0:
Region I:
Region II:
Region IlI:
Region IV:
Region V:

1Region 48 Region 5

Fastener
#27

Outside left (repair boundary) of the repair to the left most side of the repair (absolute distance)

Left most side of the repair to the left most side of the cutout

Left most side of the cutout to the center line of the repair

Center line of the repair to the right most side of the cutout
Right most side of the cutout to the right most side of the repair
Outside right (repair boundary) of the repair to the right most side of the repair

Stiffener Input Line fields:
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MAX # Number of stiffeners in region; maximum of 8 stiffeners per region

POS  Absolute position of the stiffeners in relation to the whole repair (from the left edge of the repair); for:
REGIONS 1-4, 0.0 < POS < Max.DoublerSize;
REGION 0, POS is the absolute distance of the stiffener away from the left edge of the repair;
REGION 5, POS is the absolute distance of the stiffener away from the right edge of the repair.

CSA  Cross-sectional area of the stiffener

YNG.MOD Young’s modulus of the stiffener

HPIT  Pitch of the fasteners in the stiffener

DBLR ID - If more than 1 repair doubler, indicate which repair doubler is being used in referencing the stiffener’s
positions, 1=first doubler and 2= second doubler. If there is only 1 repair doubler, then DBLR ID=1.

Note:  Each stiffener in a region has a position, cross-sectional area, Young’s modulus, and fastener pitch in the
stiffener parameters associated with it.

Although there might not be any stiffeners in the repair or region, enter 0 (or 0.0) in the number of stiffeners,
position, cross-sectional area, Young’s modulus and pitch parameters.
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